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Chapter 1
Installing and Configuring the 
Gateway for Microsoft 
Exchange

he RightFax Gateway for Microsoft Exchange acts as a communication link between the 
RightFax server and your Exchange server, allowing your users to use Microsoft Outlook to 
send, receive, and organize fax documents. Outbound e-mail messages addressed to the 

Gateway for Microsoft Exchange are picked up by the RightFax server, which converts them into 
faxes and transmits them. Incoming faxes can be routed to an e-mail mailbox by specifying each 
RightFax user’s mailbox information in Enterprise Fax Manager. The gateway can also provide 
notification of fax events via e-mail.

With the Gateway for Microsoft Exchange, you can also synchronize your RightFax and Exchange 
user databases. This lets you administer both systems directly from your Exchange administration 
program and ensure that both Exchange and RightFax client information is consistently and 
correctly updated.

The RightFax Gateway for Microsoft Exchange is comprised of several components that allow two-
way communication between the Exchange and RightFax servers:

8 One or more RightFax gateways are installed on the RightFax server and can be configured from 
Enterprise Fax Manager (see ”Adding and Configuring the Gateway for Microsoft Exchange” on 
page 6).

8 The RightFax Connector is an Exchange service that handles all communication between the 
Exchange and RightFax servers as well as user database synchronization. The RightFax 
Connector consists of connector objects and the RightFax connector service and is configurable 
from the Exchange Admin program (see ”Configuring the RightFax Connector for Microsoft 
Exchange 5.x” on page 15). 

8 Outlook forms allow Microsoft Outlook clients to create and send faxes from a RightFax form 
built into and launched directly from Outlook. Outlook forms also let clients receive new faxes 
into a form that includes a built in fax viewer. Advanced forms can be installed on each client 
workstation separately or a simplified form can be made available to all Outlook clients without 
a separate installation on each workstation. When you install the advanced Outlook form, a 
custom fax button is also added to the Outlook toolbar that lets users easily create and address 
new faxes.

8 Database synchronization tools, including a MAPI database field mapping utility for Exchange 
5.x, and Active Directory support for Exchange 2000, allow for unified administration of both 
the Exchange and RightFax servers.

Note  RightFax includes four additional e-mail gateways (Microsoft Mail, Lotus cc:Mail, Novell GroupWise, 

and SMTP/POP3) built into the RightFax server software, however these gateways do not include the 

sophisticated functionality and feature sets of the Gateway for Microsoft Exchange.

T
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Before You Activate the Gateway for Microsoft Exchange

Microsoft Exchange Server must be installed on an Intel-based Windows NT or Windows 2000 
server that meets or exceeds Microsoft’s minimum hardware requirements. Log on to the RightFax 
server using an ID with local administrative rights. If you do not, configuration will not work.

Activating the Gateway for Microsoft Exchange

The files required by the Gateway for Microsoft Exchange are installed on all RightFax servers 
during the server installation. However, the Gateway for Microsoft Exchange must be licensed and 
activated before gateway functionality will be enabled.

The RightFax Gateway for Microsoft Exchange is automatically activated on several types of 
RightFax server. For these server types, no additional steps are required.

To activate the Gateway for Microsoft Exchange on other types of RightFax servers, you must have 
purchased and licensed the Gateway for Microsoft Exchange. For information on activating new 
components on the RightFax server, refer to the RightFax Installation Guide.

After the Gateway for Microsoft Exchange has been activated on the RightFax server, you must add 
the gateway and configure it to communicate with your Exchange server (described in the next 
section).

Adding and Configuring the Gateway for Microsoft Exchange

After you have activated the Gateway for Microsoft Exchange, you must add the gateway and 
specify several configuration options. If you did not add an e-mail gateway during the RightFax 
server installation, you can open the E-mail Gateway configuration program from Windows Control 
Panel. If you already have one or more e-mail gateways configured, you can open the E-mail 
Gateway configuration program by double-clicking the RightFax E-mail Gateway service in 
Enterprise Fax Manager.

To add a new gateway, click Add Gateway and select the gateway type to add. Because RightFax 
allows you to install multiple e-mail gateways, each installed gateway is listed in the tree on the left. 
Click each gateway in the list to view its configuration options.

Configuring the options on the General tab

Figure 1.1  The General Tab on the E-mail Configuration Dialog Box

Because RightFax allows you to install multiple e-mail gateways, each installed gateway is listed in 
the left pane. Click MSEXCH to view the Gateway for Microsoft Exchange configuration options.
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Location of mail files. The Gateway for Microsoft Exchange creates In and Out subfolders under the 
folder you specify here. The In folder is where the gateway will place incoming mail-bound faxes 
for delivery to the Exchange server. The Out folder is where the gateway will look for outgoing fax-
bound mail messages for delivery to the RightFax server.

If you are running Microsoft Exchange 5.x, you must specify a folder on the RightFax server. Both 
the gateway connector service account (described on page 8) and the account used by the RightFax 
E-mail Gateway Module service (described on page 9) must have full access to this folder.

If you are running Microsoft Exchange 2000, you must specify a folder on the Exchange server. You 
can specify any folder on the Exchange 2000 server; however, by default, the gateway connector 
service account (described on page 8) looks for the In and Out folders in the connector install folder 
Program Files\RightFax\RFaxGate folder.

FROM message. Enter a descriptive name that will appear in the From field of all inbound documents 
sent to Exchange from the RightFax server.

Default form. If you have installed Outlook fax forms for your Outlook clients (see ”Installing the 
RightFax Forms for Outlook” on page 37), select the form you want Outlook users to see when 
opening received fax messages.

Remote E-mail gateway service. Allows the e-mail gateway processes to execute on a remote 
computer rather than on the local computer. (It also prevents the e-mail gateway service from being 
started by the RightFax server, so do not select this check box if you don’t intend to run the gateway 
remotely.) For more information on running the gateway remotely see ”Running the Gateway for 
Microsoft Exchange Remotely” on page 9.

Use PCL convertor for text files. Uses the RightFax PCL conversion engine when converting e-mail 
messages to fax format. This conversion method usually produces more accurate fax images of 
ASCII text than RightFax’s native document conversion engine. If you notice that e-mail messages 
are not converting to fax format as accurately as you expect, clear this check box to return to using 
the native document conversion engine.

Disable outbound faxing. Prevents Outlook clients from sending mail messages to fax addresses. 
When you select this option, the Gateway for Microsoft Exchange will only serve to route received 
faxes and notifications to Outlook clients.

Send through DEFAULT user when e-mail sender is unknown. Assigns fax ownership to the RightFax 
“Default” user ID when a fax is sent from an Outlook client who does not have a RightFax user ID. 
If this option is not selected, faxes sent from Outlook clients that have no matching RightFax user ID 
will not be sent.

Event Loglevel. Select the level of information logged in the Application Event Log under the service 
name “RightFax E-mail Gateway Module.” The Terse setting records critical errors only. Verbose 
records all significant events and is most useful for tracking and resolving problems. Note that if 
you leave this value set to Verbose for long periods of time, the Event Log can become full which 
may prevent new events from being logged.

Note  Information written to the Application Event Log is valuable in tracking down problems. If you have a 

problem that can be duplicated, set the LogLevel for all RightFax server applications to Verbose, then go 
through the steps to duplicate the problem. The data stored in the Application Event Log may help you resolve 

the problem.

Frequency. Sets the interval, in seconds, between checks to the mail system and the RightFax system 
for work to do (such as received faxes to route or e-mail to convert to faxes). Decreasing this value is 
not recommended as it may unnecessarily increase the load on the fax server.

Top margin of message header. Enter the number of lines to add to the top margin of mail messages 
when converting to fax format. Adding a few lines to the top margin may prevent come plain paper 
fax machines from cutting off the top of the message headers.
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Configuring the options on the Custom Messages tab

When a fax is received as an e-mail attachment and when an e-mail notification about the status of a 
fax is received, the received mail message includes one or more customizable messages providing 
information about the status of the fax. To customize the text of these messages, click the Custom 
Messages tab.

Figure 1.2  The Custom Messages Tab on the E-mail Configuration Dialog Box

Each message lets you combine text with one or more variables. Each message has its own available 
variables, described in the following table.

Selecting a service account

The RightFax Gateway for Microsoft Exchange logs on to the network as a service using a Windows 
user account that you specify. To change the gateway service account, click Select Service Account. 
This opens the Select Service Account dialog box.

Table 1A  E-mail Gateway Custom Message Settings

Notification message Variables

Sent/Received time ~1 = Date (in Windows locale format) and time (HH:MM)

Received remote ID ~1 = Remote ID

Sent remote ID
~1 = The destination fax number
~2 = The destination remote ID

Inbound user
~1 = The RightFax user ID of the fax recipient

~2 = The fax recipient's routing code

Result
~1 = The result code and any accompanying text as reported by the fax board 
(These codes and messages may differ depending on your fax board type)

Page record ~1 = The range of page numbers successfully sent or received

None sent None.

Elapsed time
~1 = The total time that the fax spent being processed by the fax board 
displayed (MM:SS)

~2 = The fax channel used to send or receive the fax.
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Figure 1.3  The Select Service Account Dialog Box

Enter the new service account in the Domain or Workgroup and User Account boxes. You can also click 
Load Users to scan for and list all user accounts on the network, and then click a user account in the 
list to fill in the Domain or Workgroup and User Account boxes. Enter the case-sensitive password for 
the selected user account in both the Password and Confirm Password boxes. Click OK to apply the 
new service account.

Starting and stopping the gateway service

After installing the Gateway for Microsoft Exchange, a new service called “RightFax E-mail 
Gateway Module” is created. If the gateway is running on the fax server, the service is set to 
“Manual” and is automatically started and stopped by the RightFax Server service and you should 
not stop the RightFax E-mail Gateway Module service manually. If the gateway is running on a 
remote machine (see ”Running the Gateway for Microsoft Exchange Remotely” on page 9) you must 
start and stop the RightFax E-mail Gateway Module service manually.

Running the Gateway for Microsoft Exchange Remotely

By default, the RightFax E-mail Gateway Module service runs on the RightFax server. You may 
choose to run the E-mail Gateway Module service on a different machine if:

8 You want to decrease the workload on the RightFax server.

8 You anticipate a high volume of gateway traffic and don’t want the added workload to interfere 
with the routine operation of the RightFax server.

To run the RightFax E-mail Gateway Module service remotely

1. Run Enterprise Fax manager.

2. Select the RightFax server where the Gateway for Microsoft Exchange is installed, and double-
click the RightFax E-mail Gateway Module service. This opens the E-mail Configuration dialog 
box.

3. Check the Remote E-mail Gateway Service option to enable remote operation.

4. On the remote computer where you want to run the E-mail Gateway Module service, map a 
drive to the RightFax folder on the RightFax server.

5. Open a command prompt window and switch to the Gateway folder on the drive you mapped.
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6. Run the Gateway.exe program using the following syntax:

EXCHGATEWAY -Lpath -Fdatabase -SGATEWAYn

Where path is the path to the RightFax folder on the RightFax server, database is the name of 
the server containing the RightFax Database module, and n is the number of the e-mail gateway. 
This number is zero-based, so your first e-mail gateway is referred to as “GATEWAY,” your 
second e-mail gateway is referred to as “GATEWAY1,”your third e-mail gateway is referred to as 
“GATEWAY3,” and so on. To confirm the gateway number, open the Windows registry and check 
the Gateway keys under HKEY_LOCAL_MACHINE\SOFTWARE\RightFax\Gateways.

Example EXCHGATEWAY -LR: -FRFAXSERV -SGATEWAY

This example starts the remote gateway service process from the R: drive, which is 
mapped to the Program Files\RightFax folder on the RightFax server. The process will 
look for the RightFax Database module on the server “RFAXSERV.”

Troubleshooting the Gateway for Microsoft Exchange

If you experience problems with your RightFax E-mail Gateway Module service, you should first 
check for errors in the Application log of the Windows Event Viewer. To open the Event Viewer, 
select Start > Programs > Administrative Tools > Event Viewer. In the Event Viewer, select Application 
from the Log menu to open the Application log. E-mail gateway-related problems will appear on the 
log in the Source column as “RightFax E-mail Gateway Module.” Double-click the entry for a 
description of the error.

The information saved to the Event log is determined by the LogLevel setting in the RightFax E-mail 
Gateway configuration program (described on page 7). With the log level set to Terse, only critical 
errors will be recorded. Log levels Normal and Verbose record more information that may help track 
down problems.

Running the RightFax E-mail Gateway Module service in a command prompt window will also give 
a very detailed account of what is happening with the gateway.

To run the gateway in a command window

1. Stop the RightFax E-mail Gateway Module service.

2. Open a command prompt window.

3. Change to the RightFax\Gateway folder on the RightFax server and enter this command:

EXCHGATEWAY -D -1 -SGATEWAYn

Where n is the number of the e-mail gateway. This number is zero-based, so your first e-mail 
gateway is referred to as GATEWAY, your second e-mail gateway is referred to as GATEWAY1, 
your third e-mail gateway is referred to as GATEWAY3, and so on. To confirm the gateway 
number, open the Windows registry and check the Gateway keys under 
HKEY_LOCAL_MACHINE\SOFTWARE\RightFax\Gateways.

Example EXCHGATEWAY -D -1 -SGATEWAY

When running the e-mail gateway in a command window, you must set the window properties to 
allow you to scroll backwards some distance. To set the command window to sufficient size, click 
the MS-DOS icon in the top left of the command window. Click Properties to open the Command 
Prompt Properties dialog box. Click the Layout tab, and then set Screen Buffer Size height to 2000.

Error 2140 starting service or logging into Exchange

Ensure that the appropriate Windows NT account is being used. Open the Services program in 
Control Panel. Highlight RightFax E-mail Gateway and click Startup. The Account box should 
display an account name. If not, start the gateway with an account that has administrative access. 
The default is RIGHTFAXUSER. Log off and back on using this account.
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Error 53

This is a Windows NT networking error which indicates that the UNC name which was specified 
for the Location of Mail Files in the gateway configuration is an invalid network path. If the specified 
path is correct and valid, it may be that the account being used to start the E-mail Gateway Module 
service does not have access rights to that folder.

Error 85 The local device is already in use

This is a Windows NT networking error stating that the drive to which RightFax is trying to connect 
the UNC name that was specified for the Location of Mail Files, or API Files is already assigned.

Faxes are going out, but no e-mail notifications are being sent

Normally, users who send faxes via mail do not have a RightFax account and the faxes will be 
routed through the RightFax Default fax mailbox. When a fax goes out, RightFax tries to notify the 
user of the fax status. Since the fax went through the Default fax mailbox, RightFax will try to notify 
the network user Default, thus the notification never reaches the sender.

Cannot access inbound/outbound folder

The folder entered as the Location of In/Out Directories box on the RightFax Connector dialog box is 
invalid (see ”In/Out Directories” on page 17). The path specified may not exist, may be misspelled, 
may not use proper UNC naming conventions, or the user account specified for the RightFax 
Connector Service may not have administrative access to the specified folder.

Error resolving destination mailbox: MailBoxName

An incoming fax from the RightFax server could not be converted correctly. This is usually due to 
the user’s Routing Info box in Enterprise Fax Manager not matching a display name of an Exchange 
mailbox. Make sure the user’s RightFax user ID matches an Exchange user’s Display Name.

� � �
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Chapter 2
Installing the RightFax 
Connector for Microsoft 
Exchange 5.x

nce you have installed and configured the Gateway for Microsoft Exchange, you must install 
and configure the RightFax Connector. This is the Exchange service that handles all 
communication between the Exchange and RightFax servers.

The RightFax Connector for Microsoft Exchange is made up of several objects installed in the site 

container. Each connector object is indicated in bold in the following description:

Configuration
Add-Ins

Extension for RightFax Connector
Addressing

E-mail Address Generator
RightFax Address Generator

One-Off Address Templates
English/USA

RightFax Address
French

RightFax Address
German

RightFax Address
Connections

RightFax Connector
Site Addressing

RFAX

The RightFax Connector for Microsoft Exchange service is made up of several files that direct the 
fax process through Exchange:

8 RFaxgate.exe is the main connector service.

8 RFax_in.dll performs inbound fax information processing.

8 RFax_out.dll performs outbound fax information processing.

8 RFXadmin.dll handles fax configuration in Exchange Admin.

8 RFaxprox. dll is the proxy address generator.

O
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Installing the RightFax Connector on Microsoft Exchange 5.x Servers

Note  These installation instructions apply only if you are running Microsoft Exchange Server version 5.x. If 

you are running Microsoft Exchange 2000 Server, see ”Installing the RightFax Connector on Microsoft 

Exchange 2000 Servers” on page 24.

To install the RightFax Connector on a Microsoft Exchange 5.x server, you must log on to the 
Exchange server with an ID that has Exchange Service Account Administrator privileges. This 
account must be able to access the RightFax\Gateway folder on the RightFax server, and should also 
have administrative rights on both the Exchange and RightFax servers.

The RightFax Connector for Microsoft Exchange provides two installation options: full installation 
of the connector service and objects, and an address templates-only option. You must complete the 
full installation on at least one Exchange server within your Exchange site.

Note  If you are running multiple Exchange sites, you can install a single connector to service all of the 

Exchange servers in every site only if you have configured Exchange directory replication. In this case, you 

must still install the RightFax address templates on an Exchange server in each of the additional sites 

(described on page 15). These templates provide Exchange users a way to enter data needed for outbound 

faxing via RightFax.

To perform a full installation of the RightFax Connector for Microsoft Exchange 5.x

1. Log on to your Exchange server with an account that has Exchange Service Account 
Administrator privileges.

2. Run the Setup.exe file located in the RightFax\Gateway\Setup for the Exchange 5.x connector 
folder on the RightFax server. This will start the RightFax Connector setup wizard.

3. Click Next after reading the initial Information screen to open the Installation Options screen.

Note  Several Exchange containers are modified during the connector installation. Most of these contain 

information that is static and should not be changed under any circumstances.

4. From the Installation Options screen, select Full Install. Setup will ask you to enter an Install 
Directory on the Exchange server where the connector will be installed. Click Next to proceed 
using the default folder name.

5. Fill in the UNC path to the RightFax e-mail gateway folder on the RightFax server (e.g., 
\\RFServer\Program Files\RightFax\Gateway). Click Next to continue.

6. Fill in the name of the Exchange server that you want to handle fax messaging. Click Next. Setup 
will scan your network and display a list of all available Exchange sites. Select the Exchange site 
you want to synchronize with RightFax, and then click Next.

7. Enter the domain and account name to be used by the connector service. This should be the same 
account your other Exchange services use to start up. Enter and then confirm the password for 
the account you specify. Click Next. The setup wizard will now install the RightFax Connector.

8. In the Enable Sync dialog box, select whether to enable or disable Exchange synchronization. This 
allows you to synchronize your Exchange and RightFax user databases. For more information on 
database synchronization between RightFax and Exchange 5.x servers see Chapter 4, 
”Synchronizing Exchange 5.x and RightFax User Accounts”.)

9. When the Setup program is complete, click Finish to quit.



RightFax 8.5 Gateway for Microsoft Exchange Guide 15
To install the connector templates only

You should choose this limited installation option only if your Exchange configuration has multiple 
Exchange sites. Because template files cannot be replicated between sites automatically by 
Exchange, you must install the templates manually to an Exchange server at each additional site in 
your organization.

Follow the steps for the full installation, but at the Installation Options screen, select Templates Only. 
This installation requires no additional steps.

Configuring the RightFax Connector for Microsoft Exchange 5.x

After the RightFax Connector for Microsoft Exchange has been installed, you should configure it 
while still logged into the Exchange server with Exchange Service Account Administrator 
privileges.

To configure the RightFax Connector for Microsoft Exchange 5.x

1. On the Exchange server, run the Microsoft Exchange Admin program.

2. Select Connections from the Configuration container under the Exchange site where you installed 
the connector. If you have properly installed the connector, it will appear as an option here.

Figure 2.1  Location of the RightFax Connector in Exchange Administrator

3. Double-click RightFax Connector. This opens the RightFax Connector Properties dialog box. Click 
the Administration tab.
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The rest of this section describes each of the options on this dialog box.

Figure 2.2  The RightFax Connector Properties

Enable OutBound. Select this check box to allow e-mail messages to be sent as faxes directly from 
Exchange and Outlook clients.

Enable InBound. Select this check box to allow received faxes to be forwarded as e-mail messages to 
Exchange and Outlook clients.

FAX Addresses. Specify when to accept fax addresses using the FAX addressing type. This is a 
simplified fax addressing type that lets users specify only the destination name and fax number in 
the format:

[FAX:Name@FaxNumber]

(Be sure to include the opening and closing square brackets.)

You can allow this type of fax address from users across the organization, site, or location. Select Do 
Not Accept to require users to use the RFAX addressing method. If you select Custom, you can 
customize the scope of this address type on the Address Space tab.

RFAX Addresses. Specify when to accept fax addresses using the RFAX addressing type. This is an 
advanced fax addressing type supported by RightFax that lets users specify the destination name 
and fax number in the format:

[RFAX:Name@/FN=FaxNumber]

(Be sure to include the opening and closing square brackets.)

You can allow this type of fax address from users across the organization, site, or location. Select Do 
Not Accept to require users to use the FAX addressing method. If you select Custom, you can 
customize the scope of this address type on the Address Space tab.

Logging Level. Specifies the level of information logged in the Application Event Log under the 
service name “RightFax E-mail Gateway Module.” The “Normal” setting records critical errors only. 
“Debug” records all significant events and is most useful for tracking and resolving problems. Note 
that if you leave this value set to “Debug” for long periods of time, the Event Log can become full 
which may prevent new events from being logged.

Enable Message Tracking. When this check box is selected, the connector will write a tracking event 
in the Exchange Message Tracking Log for all fax messages successfully sent to and received from 
RightFax. For received fax messages, the Tracking Log records the fax’s RightFax unique ID, the 
CSID of the sending fax machine, and the Exchange ID of the fax recipient. For sent faxes, the 
Tracking Log records the Exchange ID of the sender, the destination fax address, and the MTS-ID.
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If message tracking is enabled, you can force all faxes sent via the connector to use the last 15 digits 
of the Message Tracking Log’s MTS-ID as the fax’s unique ID in RightFax. This will help you locate 
sent faxes in RightFax that have been identified in the Message Tracking Log.

To enable this feature, edit the Windows registry. Navigate to 
HKEY_LOCAL_MACHINE\Software\RightFax\Gateway\Gateway#. Next, add the registry value 
class DWORD and the value “UseMTSID.” Set its value to hexadecimal “0x1” by entering 1 in the 
DWORD editor.

In/Out Directories. Select one or more paths to the gateway folder on the RightFax server(s). Each 
connector can communicate with up to ten gateways on multiple RightFax servers. This may be 
useful for configuring redundancy into organizations with several RightFax servers. The connector 
uses gateway folders (also called In/Out folders) to store fax-bound mail messages and to pick up 
mail-bound faxes.

To add, edit, or delete in/out folders, click Change. This opens the Directory Selection dialog box.

Figure 2.3  The Directory Selection Dialog Box

This dialog box lists each gateway folder the connector will communicate with. To add a new folder, 
right-click in the dialog box to open a shortcut menu, click Add New, and then type the UNC path to 
the new gateway folder. To delete a folder, right-click the folder to open a shortcut menu, and click 
Delete.

You can also assign each In/Out folder a priority. The connector will always use the folder with the 
lowest priority setting. If a folder can’t be found, it will use the next lowest. If two folders have the 
same priority, the connector will alternate folders. The connector will automatically perform user 
synchronization (if enabled) on any gateway with a priority of 1, 2, or 3. The connector will never 
perform user synchronization on gateways with a priority of 4 or 5. To assign a priority, right-click 
the folder to open a shortcut menu, and select the priority setting.

When configuring the Outlook Fax Extension, users can specify the RightFax server to connect to.

To specify that faxes should be sent from the server specified in the Outlook client, select the check 
box Enable server destination validation. When sending a fax, Exchange will attempt to send via the 
specified server. If the server is not available, Exchange will use one of the servers specified in the 
Directory Selection dialog box, in priority order.

Default Exchange Administrator. Select an Exchange administrator account. This account will receive 
inbound faxes from RightFax that are undeliverable, and will also receive notification of 
synchronization events. To change this setting, click Change and select the new Exchange 
administrator from the list.
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Enable User Synchronization. Enables Exchange/RightFax user database synchronization. This lets 
you update RightFax user accounts from Exchange user accounts. Modifications to users in 
Exchange are applied to the same users in RightFax. Also, new user accounts from Exchange will be 
created in RightFax. Deleted user accounts in Exchange will be deleted from RightFax.

Synchronized Containers. Select the Exchange containers to synchronize with RightFax. Click the 
browse button to open the Select Synchronization Sites dialog box.

Figure 2.4  The Recipient Container to Be Synchronized With RightFax

Each available container is listed in the Available Containers list. To select a container, enter a server 
name in the Exchange Server box, and then click the container you want and click the RIGHT 
ARROW key to move the container to the Selected Containers list. You can select up to 150 containers 
on as many servers as you want. When you have selected the containers you want synchronized 
with RightFax, click OK.

Connector State. Indicates whether the connector is started or stopped. Click Start/Stop to start and 
stop the connector.

Advanced options

Click Advanced Options to open the Advanced Options dialog box. Use this dialog box to customize 
Exchange and RightFax user database synchronization.
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The User Creation tab

Figure 2.5  The User Creation Tab

Use Last x Digits of Fax Number. Enter the number of digits in the Exchange user’s Fax Number field 
to be automatically entered as the same user’s RightFax Routing Code field for inbound routing. Set 
to 0 (zero) to disable.

Enable DID Validation. Select this check box to automatically verify that new RightFax user IDs 
created during user synchronization have unique Routing Code settings. If the value is not unique, 
Exchange will log an error to the Sync Log (which is automatically e-mailed to the administrator’s 
inbox after the synchronization is complete) and set the new user’s Routing Code in RightFax to 
“100.” This prevents duplication of existing RightFax users’ Routing Code settings.

Route to Exchange. Select this check box to automatically set the RightFax Routing Type field to 
“Microsoft Exchange” for all new RightFax users generated by the Exchange/RightFax 
synchronization process.

Delete After Routing. Select this check box to automatically enable the Delete After Routing option for 
all new RightFax users generated by the Exchange/RightFax synchronization process.

Object Types. Check which exchange objects to synchronize with RightFax. Exchange mailboxes 
correspond directly to individual RightFax IDs. When an Exchange distribution list is synchronized, 
the distribution list corresponds to user ID in RightFax. Faxes arriving to that user ID are forwarded 
to the Exchange distribution list which then distributes them normally. When an Exchange public 
folder is synchronized, the folder corresponds to user ID in RightFax. Faxes arriving to that user ID 
are forwarded to the Exchange folder.

Note  For public folders to receive inbound fax messages, they must grant the “Anonymous” login 

permission.

Use Last x Digits of Voice Number. Enter the number of digits in the Exchange user’s Phone Number 
field to be automatically entered as the same user’s RightFax Voice Mail Subscriber ID. Set to 0 (zero) 
to disable.

Enable VMSID Validation. Select this check box to automatically verify that new RightFax user IDs 
created during user synchronization have unique Voice Mail Subscriber ID settings. If the value is not 
unique, Exchange will log an error to the Sync Log (which is automatically e-mailed to the 
administrator’s inbox after the synchronization is complete) and set the new user’s Voice Mail 
Subscriber ID in RightFax to “100.” This prevents duplication of existing RightFax users’ Voice Mail 
Subscriber ID settings.
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Re-Sync All Users Now. Click this button to immediately synchronize all Exchange user accounts with 
RightFax. This option only should be used when you need to replace all user accounts in the 
RightFax database.

For more information on synchronization see Chapter 4, ”Synchronizing Exchange 5.x and RightFax 
User Accounts”.

Sync Now. Click this button to immediately synchronize only modified Exchange user accounts with 
RightFax. This option updates the RightFax database with any new, modified, or deleted user 
accounts made since the last scheduled or forced synchronization.

For more information on synchronization see Chapter 4, ”Synchronizing Exchange 5.x and RightFax 
User Accounts”.

Template User. Specifies which RightFax user account will be used as a template for all new RightFax 
users generated by the Exchange/RightFax synchronization process.

Configure Mappings. Click this button to open the MAPI-to-RightFax Property Mapper utility. This 
utility lets you associate Exchange user fields with RightFax user fields. During user 
synchronization, data will be automatically transferred from Exchange fields to the RightFax fields 
they are mapped to. For information on using the MAPI-to-RightFax Property Mapper utility see 
”Using the MAPI-to-RightFax Property Mapper Utility” on page 33.

Notify via Exchange. Select this check box to automatically set the RightFax Notification Method field 
to “Microsoft Exchange” for all new RightFax users generated by the Exchange/RightFax 
synchronization process.

Create Users on Modify. Select this check box to automatically create a new user in RightFax when, 
during a synchronization, an Exchange user is reported as modified but has no equivalent user ID in 
RightFax. This may be useful if a user ID is deleted from RightFax but not Exchange.

The User Maintenance tab

Figure 2.6  The User Maintenance Tab

Notify Options. Check which automatic RightFax user account events for which you want e-mail 
notification sent to the Exchange administrator.

Delete Users. Specifies when to delete a RightFax user after the same user is deleted from Exchange.

Disable User Extension. When this check box is selected, the RightFax user extension (see ”The 
RightFax User Extension” on page 35) is disabled.
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The Sync Schedule tab

Figure 2.7  The Sync Schedule Tab

Interval. Click to specify an interval between Exchange/RightFax user database queries. After each 
query, any modifications to user accounts in Exchange are applied to their linked user accounts in 
RightFax. If this option is selected, you must also enter the interval.

Specific Time. Click to specify a specific time of day for Exchange/RightFax user database queries. 
After each query, any modifications to user accounts in Exchange are applied to their linked user 
accounts in RightFax. If this option is selected, you must also specify the time.
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Configuring the Connector to Work with Multiple Exchange Gateways

Only one RightFax connector can be installed on each Exchange server, although each connector can 
communicate with multiple RightFax gateways. Each connector/gateway connection can be 
assigned a priority. The connector will always use the gateway with the lowest priority setting. If a 
gateway can’t be found, it will use the next lowest. If two gateways have the same priority, the 
connector will alternate gateways. The connector will automatically perform user synchronization 
(if enabled) on any gateway with a priority of 1, 2, or 3 and will never perform user synchronization 
on gateways with a priority of 4 or 5.

The following diagram illustrates the use of connection priorities to create redundancy in a multiple 
RightFax/Exchange server environment.

Figure 2.8  RightFax/Exchange Server Redundancy

Server redundancy is enabled by assigning multiple In/Out folders (one per installed gateway) to a 
single connector, and assigning each a different priority level. For information on configuring In/
Out folders in the RightFax connector for Microsoft Exchange, see ”In/Out Directories” on page 17.

� � �
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Chapter 3
Installing the RightFax 
Connector for Microsoft 
Exchange 2000

nce you have installed and configured the Gateway for Microsoft Exchange, you must install 
and configure the RightFax Connector. This is the Exchange 2000 service that handles all 
communication between the Exchange 2000 and one or more RightFax servers. The connector 

object is indicated in bold in the following description:

Organization
Routing Groups

Routing Group
Connectors

 Connector for Captaris RightFax

The RightFax Connector for Microsoft Exchange is made up of several files that direct the fax 
process through Exchange 2000:

8 RFaxgate.exe is the main connector service.

8 RFax_in.dll performs inbound fax information processing.

8 RFax_out.dll performs outbound fax information processing.

8 ExchSnap.dll handles fax configuration in Exchange System Manager.

O
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Installing the RightFax Connector on Microsoft Exchange 2000 Servers

NoteThese installation instructions apply only if you are running Microsoft Exchange 2000 Server. If you are 

running Microsoft Exchange Server version 5.x, see ”Installing the RightFax Connector on Microsoft Exchange 

5.x Servers” on page 14.

To install the RightFax Connector for Microsoft Exchange, you must be logged on to the Exchange 
2000 server with an account that is a member of all of the following Exchange 2000 groups:

8 Enterprise Admins

8 Schema Admins

8 Domain Admins

In addition, you must be able to access the RightFax\Gateway\Setup for the Exchange 2000 
connector folder on the RightFax server.

To install the RightFax Connector for Microsoft Exchange 2000

1. Log on to the Exchange 2000 server.

2. In the RightFax\Gateway\Setup for the Exchange 2000 connector folder on the RightFax server, 
double-click to run E2KSetup.msi. This will start the RightFax Connector setup wizard.

3. Click Next after reading the initial Information screen to open the Installation Options screen.

4. Select Complete or Custom, and then click Next.

Note  If you want to install the connector to a folder other than the default folder Program 

Files\RightFax\RFaxGate, or if you want to install the MMC Administrative Tool (described on page 25) 

only, you must select the Custom option.

5. Click Next on each of the Install Options screens. In most cases, accepting the default settings on 
these screens is recommended. When prompted, click Install.

6. The Exchange 2000 schema must be updated in order to proceed with the install. If this is 
necessary, you will be prompted to begin updating the schema. This process may take a few 
minutes or as long as several hours, depending on the size of your Active Directory domain. 

A message may appear indicating that the install is unable to add the connector object. Click 
Retry to check the progress of the update. If the update is still in progress, the message will 
reappear. If the update is complete, the message will close and the install will continue. 

7. If the setup program detects multiple Exchange 2000 servers on your network, you will be 
prompted to select the server to install the connector on. Select the server you want, and then 
click Next.

8. Click Finish to complete the install.

9. When the install is complete, run the Services application in Windows Control Panel and start 
the RightFax Connector service.

To Configure the RightFax server to work with the connector

After the connector software has been installed, follow these steps to configure the RightFax server:

1. On the RightFax server, run Enterprise Fax Manager.

2. Open the RightFax server that has the Gateway for Microsoft Exchange installed and double-
click RightFax E-mail Gateway Module in the list of services. This opens the E-mail Configuration 
dialog box. Click the General tab.

3. In the Location of mail files box, enter the location of the message transfer directory you specified 
during the connector installation. If you accepted the default folder location during the 
connector installation on the Exchange 2000 server, this is the ExchServer\Program 
Files\RightFax\RFaxGate folder.
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Configuring the RightFax Connector for Microsoft Exchange 2000

After the connector is installed, you can customize the connector configuration settings in the 
Exchange System Manager using the MMC Administrative Tool.

Note  You can install the MMC Administrative Tool for the RightFax Connector on any computer that has 

Exchange System Manager installed. To install the MMC Administrative Tool only, run the installation 

program for the RightFax Connector for Exchange 2000 (described on page 24), select the Custom option, 
and then select only the MMC Administrative Tool option from the list of components.

To configure the RightFax Connector for Microsoft Exchange 2000

1. Run the Exchange System Manager program.

2. Navigate to Connectors, right-click Connector for Captaris RightFax, and then select Properties in 
the shortcut menu.

The rest of this section describes each of the options in this dialog box.

The General tab

Figure 3.1  The Connector for Captaris RightFax Properties General Tab

Message size. Select No limit to accept all messages from the fax server regardless of the file size of 
the message. Select Maximum (KB) to specify the maximum file size of messages that the Exchange 
server will pass to the fax server. Enter the maximum file size in kilobytes. Messages that exceed this 
file size will not be forwarded to the fax server.

Delivery order. Select the sequence that the Exchange Message Transfer Agent (MTA) will use when 
delivering mail to the connector:

8 FIFO. The MTA delivers messages to the connector on a first-in first-out (FIFO) basis.

8 Priority. The MTA delivers messages marked with a high priority first. 

8 Size. The MTA delivers messages that are smallest first.

Logging level. Select the level of information that will be logged in the Application Event Log under 
the service name “RightFax E-mail Gateway Module.” Normal records critical errors only. Debug 
records all significant events and is most useful for tracking and resolving problems.

If you leave this option set to Debug for long periods of time, the Event Log can become full very 
quickly, which will prevent new events from being logged.
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Enable message tracking. Select this option to write a tracking event in the Exchange Message 
Tracking Log for each fax message successfully sent to or received from the fax server.

For received faxes, the Message Tracking Log records:

8 The unique ID of the fax, assigned by the fax server.

8 The caller service identification (CSID) of the sending fax machine.

8 The object distinguished name of the fax recipient.

For sent faxes, the Message Tracking Log records:

8 The Exchange ID of the sender.

8 The destination address for the fax.

8 The message transfer system identification (MTS-ID) assigned by the connector.

When message tracking is enabled, you can force all faxes sent via the connector to use the last 15 
digits of the MTS-ID as the unique ID of the fax. This will help you locate faxes on the fax server that 
have been identified in the Exchange Message Tracking Log. To enable this feature, edit the 
Windows registry. Navigate to HKEY_LOCAL_MACHINE\Software\RightFax\
Gateway\Gateway#. Next, add the registry value class DWORD and the value “UseMTSID.” Set its 
value to hexadecimal “0x1” by entering 1 in the DWORD editor.

The Fax Server tab

Figure 3.2  The Connector for Captaris RightFax Properties Fax Server Tab

Message transfer directories. Message transfer directories store the mail messages that are being 
routed to the fax server and the fax images that are being routed to the Exchange server. You must 
specify one message transfer directory for each fax server that the Exchange 2000 connector will 
communicate with. The message transfer directory must be a local folder on the Exchange 2000 
server, and it must be specified as a standard path (for example, C:\Program Files\RightFax
\RFaxGate). Each RightFax server with the Gateway for Microsoft Exchange installed is configured 
to communicate with one message transfer directory (see ”To Configure the RightFax server to work 
with the connector” on page 24).

Each message transfer directory is assigned a priority. The RightFax connector will always use the 
message transfer directory with the lowest priority setting. If a directory can’t be found, it will use 
the next lowest. If two directories have the same priority, the connector will alternate directories.

Administrator. Select an Exchange Admin account that will receive undeliverable inbound fax 
messages and notification of synchronization events.
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The Address Space tab

Figure 3.3  The Connector for Captaris RightFax Properties Address Space Tab

Create, modify, or remove an address space. This is a list of the Exchange address spaces that will be 
routed to the fax server. All messages within the address spaces specified here will be routed to the 
fax server. By default, messages with the FAX and RFAX address types (described on page 43) will 
be routed to the fax server by the connector. 

Connector scope. Select Entire organization to enable the connector for all servers on your network. 
Select Routing group to enable the connector only for servers in the local routing group.

The Delivery Restrictions tab

Figure 3.4  The Connector for Captaris RightFax Properties Delivery Restrictions Tab

By default, messages from everyone are. Click Accepted to accept fax-bound messages from all 
sources. If you select this option, you will still be able to reject messages from specified sources. You 
should select this option if you intend to accept messages from all but a few sources. Specify the 
exceptions in the Reject messages from box.
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Click Rejected to reject fax-bound messages from all sources. If you select this option, you can still 
accept messages from specified sources. You should select this option if you intend to accept 
messages from only a few sources. Specify the exceptions in the Accept messages from box.

Accept messages from. This is a list of senders from whom messages will be accepted. You may want 
to add Exchange users to this list if you select Rejected as the default for all users. If so, the connector 
will only accept messages from users listed here.

Reject messages from. This is a list of senders from whom messages will be rejected. You may want 
to add Exchange users to this list if you select Accepted as the default for all users. If so, the 
connector will accept messages from all users except those listed here.

The Details tab

Figure 3.5  The Connector for Captaris RightFax Properties Details Tab

Administrative note. Add an optional note, up to 1024 characters.
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Configuring the Connector to Work with Multiple Exchange Gateways

Only one RightFax connector can be installed on each Exchange 2000 server, although each 
connector can communicate with multiple RightFax gateways through the specified message 
transfer directories (described on page 26). Each connector/gateway connection is assigned a 
priority. The connector will always use the message transfer directory with the lowest priority 
setting. If a message transfer directory can’t be found, it will use the next lowest. If two message 
transfer directories have the same priority, the connector will alternate between them.

The following diagram illustrates the use of connection priorities to create redundancy in a multiple 
RightFax/Exchange 2000 server environment.

Figure 3.6  RightFax/Exchange 2000 Server Redundancy

Server redundancy is enabled by assigning multiple message transfer directories (one per installed 
gateway) to a single connector and assigning each a different priority level. For information on 
configuring message transfer directories in the RightFax connector for Microsoft Exchange, see 
”Message transfer directories” on page 26.

Installing the Connector for Exchange 2000 on a Windows 2000 Cluster

Important  The Connector for Microsoft Exchange 2000 requires that your cluster environment be configured 

as Active-Passive. It will not function in an Active-Active Cluster configuration.

Installing the Connector for Exchange 2000 on a Windows 2000 cluster requires these basic steps:

1. Create the mail directories (page 30).

2. Install the connector on the primary node (page 30).

3. Install the connector on the secondary node (page 30).

4. Create the RFAXGATE resource (page 30).

5. Create the file share resource (page 31).

6. Change the mail directory paths (page 31).

7. Modify the Windows Registry (page 31).

8. Test communication between the two servers (page 32).
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Creating the mail directories

1. From the root of the cluster shared drive, create a new folder named RFaxGate. Add two 
subfolders to this folder named RFaxGate\In and RFaxGate\Out.

2. Right-click the RFaxGate folder and select Sharing from the shortcut menu. This opens the 
Properties dialog box with the Sharing tab displayed.

3. Select Share this folder and type “RFAXGATE” in the Share name box.

4. Click Permissions, and then click Add.

5. Select the service account used by the Exchange e-mail gateway service and click Add. Click OK.

6. Select the service account you added and allow full control. Click OK to return to the Properties 
dialog box.

7. Select the Security tab and click Add.

8. Select the service account used by the Exchange e-mail gateway service and click Add. Click OK.

9. Select the service account you added and allow full control.

10. Click Advanced.

11. Check the Reset permissions on all child objects and enable propagation of inheritable 
permissions check box and click OK.

12. Close the Permissions dialog box.

Installing the connector on the primary node

Important  You must be working at the Exchange console for the connector to install properly. Connecting 

remotely to the server will result in an “unknown error” message and the installation will fail.

1. Log on to the primary node using an account that is a member of the Domain Admins, 
Enterprise Admins, and Schema Admins groups.

2. Install the Exchange 2000 connector according to the instructions in “Installing the RightFax 
Connector on Microsoft Exchange 2000 Servers” (page 24).

Installing the connector on the secondary node

1. Fail over to the secondary node.

2. Install the Exchange 2000 connector on the secondary node according to the instructions in 
“Installing the RightFax Connector on Microsoft Exchange 2000 Servers” (page 24).

Creating the RFAXGATE resource

1. Fail back to the primary node.

2. Run Cluster Administrator and open the Exchange cluster group. 

3. Right-click Resources, and then select New > Resource. The Generic Resource wizard opens.

4. In the Name box, enter RFSERVER.

5. In the Description box, enter RightFax Exchange Connector.

6. Set Resource Type to Generic Service.

7. Select the Exchange group.

8. In the Possible Owners box, enter the names of both nodes in the cluster by selecting them and 
clicking Add.
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9. In the Resource Dependencies box, add the MS Information Store, MS MTA, and MS System 
Attendant resources.

10. Click Finish to add the resource to the group.

Creating the file share resource

1. Right-click Resources, and then select New > Resource. The Generic Resource wizard opens.

2. In the Name box, enter RFaxShare.

3. In the Description box, enter RightFax File Share for Connector.

4. Set Resource Type to File Share.

5. Select the Exchange group.

6. In the Possible Owners box, enter the names of both nodes in the cluster by selecting them and 
clicking Add.

7. In the Resource Dependencies box, add the Cluster Name and Physical Disk resources.

8. In the Generic File Share Parameters box, enter the path to the RFaxGate folder you created on the 
virtual drive. Be sure to use RFAXGATE as the share name.

9. Click Finish to add the resource to the group.

Changing the mail directory paths

1. Open the Exchange System Manager.

2. For each node, open the Exchange Connector’s Properties window and click the Fax Server tab.

3. Change the directory path from C:\Program Files\Rightfax\RFaxGate to 
\\ClusterName\RFAXGATE on both connectors.

4. Change the Location of mail files path to the RFaxGate folder on the cluster shared drive.

5. Click OK to re-set the gateway.

Modifying the Windows Registry

When the Exchange Connectors are installed on the cluster nodes, they each point to different MTS 
queues. The registry needs to be modified to point them both to the correct queue.

1. Open the Windows Registry on the secondary node.

2. Navigate to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services
\RFaxGate\Parameters.

3. Replace the computer name of the secondary node (delimited by brackets) with the computer 
name of the primary node for the following registry values:

8 ADSConnector

8 ADsPath

8 CommonName

Important  Do not change the settings for HomeDSA. 

4. Re-start the Exchange connector.
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Testing communication between the two servers

1. Ensure that the Exchange connector service on the active node and the gateway service on the 
RightFax server are running.

2. On the active node, navigate to the virtual drive where you created the RFAXGATE file share.

3. Open the In and the Out folders in separate windows and set each view to Details.

4. Each folder should contain a file called Pulse.txt.

5. Check the “modified” time and date of each Pulse.txt file and compare them to the actual server 
time. The time and date of both Pulse.txt files should always be within one minute of the server 
because they should automatically update every 45 seconds.

8 If Pulse.txt in the In folder is not updating, ensure that the RightFax Connector service on the 
Exchange server is running.

8 If Pulse.txt in the Out folder is not updating, ensure that the E-mail Gateway service on the 
RightFax server is running.

8 If both Pulse.txt files are updating properly, send a test fax through the Exchange gateway.

� � �
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y
Chapter 4 S
Exchange 5.x and RightFax 
User Accounts

his feature of the Gateway for Microsoft Exchange lets you automatically synchronize user 
accounts in up to 150 Microsoft Exchange 5.x containers to your RightFax user accounts. 
Modifications to any Exchange 5.x user will automatically apply to the same (synchronized) user 

in RightFax. This means adding, removing, or modifying users need only be performed once but 
will apply to both applications, ensuring accuracy and saving time.

Note  User synchronization through the Gateway for Microsoft Exchange applies only to Exchange 5.x 

servers. If you are running Exchange 2000, all database synchronization between RightFax and Exchange is 

managed through Microsoft Active Directory. For information on publishing RightFax servers to Active 

Directory, refer to the RightFax Administrator’s Guide.

If you enabled User Synchronization when you configured the RightFax Connector for Microsoft 
Exchange (see ”Enable User Synchronization” on page 18), all of your Exchange users have been 
automatically added as user accounts in RightFax.

After user accounts have been synchronized, modifications to those accounts should take place in 
Exchange only. This is because changes to Exchange user accounts are reflected in RightFax, but 
changes in RightFax are not reflected in Exchange. Any change made to a RightFax user account 
may be inadvertently undone during a later resynchronization with Exchange.

Each synchronized RightFax user account listed in Enterprise Fax Manager (described in the 
RightFax Administrator’s Guide) includes a dot next to the user icon to remind you not to edit the 
account in RightFax.

Using the MAPI-to-RightFax Property Mapper Utility

The MAPI-to-RightFax Property Mapper utility lets you associate Exchange user fields with 
RightFax user fields. During user synchronization, data will be automatically transferred from 
Exchange fields to the RightFax fields they are mapped to.

To run this utility, run the Microsoft Exchange Admin program. Select Connections from the 
Configuration container under the Exchange site where you installed the connector, and then 
double-click RightFax Connector. Click the Administration tab, and then Advanced Options, and then 
click Configure Mappings.

T
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Figure 4.1  The MAPI to RightFax Property Mapper

To associate an Exchange field with a RightFax field, drag and drop the Exchange field in the left 
pane onto the desired RightFax field in the right pane. To remove an association, highlight the 
Exchange field in the right pane and press DELETE.

User fields are listed according to their type. Both Exchange and RightFax list binary values, boolean 
values, number values, and string values. Exchange includes an additional “unknown” field type. 
Exchange and RightFax fields of the same type map as-is. In some cases, you can map fields of 
different types. The following table lists how data will be mapped from Exchange to RightFax for all 
data types.

If you make changes to the field mappings, the changes will automatically apply to all users when 
the database is synchronized. To apply the changes to user accounts immediately, click Re-Sync All 
Users Now (see ”Re-Sync All Users Now” on page 20).

For a definition of each RightFax field, right-click the field name to open a shortcut menu, and then 
click Help. For definitions of the Exchange fields, please refer to your Exchange documentation.

Table 4A  Exchange/RightFax Field Type Mapping Behavior

RightFax 

binary
RightFax Boolean RightFax number RightFax string

Exchange 

binary
As-is Undefined Undefined Undefined

Exchange 

Boolean
Undefined As-is

0 = Numeric 0
1 = Numeric 1

0 = String “0”
1 = String “1”

Exchange 

number
Undefined

0 = Boolean 0

Anything else = Boolean 

1

As-is
Digits converted to 

text characters

Exchange 

string
Undefined

“1,” ”Yes,” and 

equivalents = Boolean 1

“0,” ”No,” and 
equivalents = Boolean 0

Digits in string 

converted to 
numeric digits

As-is

Exchange 

unknown
Undefined Undefined Undefined Undefined



RightFax 8.5 Gateway for Microsoft Exchange Guide 35
Default Exchange/RightFax Shared Fields

When a new RightFax user is created automatically by Exchange, RightFax first makes a copy of the 
template user ID. This user ID is specified on the User Creation tab of the Advanced Options dialog 
box (page 18). Then RightFax makes the new user unique by copying six Exchange fields into 
equivalent fields in the RightFax user configuration.

Because an Exchange client’s Common Name cannot be changed after it is created, RightFax uses this 
field to “link” an Exchange user with its counterpart user in RightFax. In this way, all other fields in 
Exchange can be modified, including the Alias, but the Exchange user and its equivalent RightFax 
user will remain linked.

The RightFax User Extension

After RightFax/Exchange user synchronization has been established, Exchange administrators can 
edit users’ RightFax properties individually via Exchange Admin. Changes to a user’s fax properties 
in Exchange always override that user’s settings in RightFax. Changes made via the RightFax User 
Extension will be applied on the next synchronization.

To access the RightFax user extension, run the Exchange Admin program and double-click the user 
in the Recipients container to open the Properties dialog box. Click the RightFax tab.

Figure 4.2  The Individual Recipient RightFax Properties Dialog Box

Table 4B  Exchange User ID Fields and Their RightFax Equivalents

This field in Exchange Is copied to this field in RightFax

Alias (Mail Nickname) User ID

Common Name Distinguished Name

Display Name User Name

Object Distinguished Name Routing Info

Telephone — Fax
Last x digits to Routing Code/

Private Fax Number

Telephone — Office 1
Last x digits to Voice Mail Subscriber ID/

Voice Number
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The RightFax properties are divided into these categories:

8 Coversheet options

8 Permission options

8 Routing options

8 Advanced options

Click each button to open the Properties dialog box for the category.

In each Properties dialog box, click to clear the Use Default check box, and then complete all the 
information on the dialog box. You must then complete all of the options on the dialog box since any 
settings left incomplete will override (effectively undoing) the equivalent settings in RightFax. If the 
Use Default check box is selected, all of the fax properties displayed in the dialog box will default to 
the settings in RightFax, and all options on the dialog box will be unavailable.

All of the options in each of these categories correspond to a setting in the User Edit dialog box in 
Enterprise Fax Manager. For a description of each option in each of the Properties dialog boxes, refer 
to the RightFax Administrator’s Guide.

If you select the Don’t Sync This Mailbox check box, this Exchange user will not be synchronized to 
RightFax. In addition, if this Exchange user already exists as a user in RightFax, selecting this check 
box will cause the associated user ID in RightFax to be deleted.

� � �
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Chapter 5
Configuring Outlook Users to 
Send and Receive Faxes

ending an Outlook mail message to a fax number is similar to sending e-mail, except the message 
must be specially addressed. Text entered in the Subject field in an Outlook mail message will 
appear in the “Notes” section of the cover sheet. Text entered in the body of the e-mail will 

appear as the body of the fax. Attached files will be converted to fax images and added to the fax 
(see Appendix B, ”File Formats that Convert to Fax Format”). Unsupported file attachments cannot 
be converted and will be ignored.

Installing the RightFax Forms for Outlook

RightFax provides custom forms for your Microsoft Outlook users that expand and simplify the 
process of sending and receiving faxes with Outlook. Features such as an embedded fax viewer and 
billing code lookup tables allow Outlook to act as a truly unified messaging client for your users.

RightFax includes two types of Outlook forms: an advanced (full-featured) form and a standard 
form that includes fewer features.

Note  Both the standard and advanced Outlook fax forms require Microsoft Outlook 98 or higher be running 

on the client workstation.

With the standard form, users can:

8 Enter billing information.

8 Send a cover sheet.

8 Specify conversion options for PowerPoint, Excel, and Visio documents.

8 Elect to preview a fax before sending, request a callback, and use smart-resume.

8 Specify the resolution of the fax image.

The advanced form includes the same features, and users can:

8 Select defaults for conversion options, cover sheets, and other sending information.

8 Preview and select library documents to attach to the fax.

8 Preview and select fax overlay forms.

8 Look up billing codes.

Preview forms can be installed so that users can preview faxes in Outlook before sending them. The 
advanced preview form displays the fax in the RightFax viewer. The standard form utilizes the 
default viewer defined for the file type.

The forms can be installed and configured (“published”) for all Outlook clients at one time. To use 
the advanced form, it is also necessary to install and configure each client individually.

S
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To install the forms to all Outlook client computers

Repeat the following steps for each form you want installed.

1. Ensure that your Exchange server has an Organizational Forms Library configured.

To check this in Exchange 5.x, run the Exchange Admin program and select Forms Administrator 
from the Tools menu. If you do not have an Organization Forms Library, add one by clicking 
New.

To check this in Exchange 2000, run the Exchange System Manager. Select Public Folders and 
then click the Action button and select View System Folders from the menu. Select the system 
folder EFORMS REGISTRY. If an Organization Forms Library is not listed, add one by right-clicking 
EFORMS REGISTRY, and then selecting New > Organizational Form from the shortcut menu.

2. Double-click the file name for the form to install. The following table lists all of the available 
forms.

3. When prompted, click Enable Macros. This opens the form.

4. On the Tools menu, click Forms and then click Publish Form As. This opens the Publish Form dialog 
box.

5. In the Look In box, select Organization Forms Library.

6. In the Display Name box, type a descriptive name for the form, such as the names shown in the 
following table. The name will appear in the Form Name box. Verify the message class for the 
form, as shown in this table.

7. Click Publish.

Table 5A  File Names for Exchange Forms on the RightFax Server

Form Language File name

Standard form

English FormEN.oft

French FormFR.oft

French-Canadian FormFC.oft

German FormGR.oft

Italian FormIT.oft

Portuguese FormPR.oft

Spanish FormSP.oft

Standard preview form

English FormENp.oft

French FormFRp.oft

French-Canadian FormFCp.oft

German FormGRp.oft

Italian FormITp.oft

Portuguese FormPRp.oft

Spanish FormSPp.oft

Table 5B  Display Names and Message Classes for Exchange Forms on the RightFax Server

Form Display name Message class

Standard form RightFax IPM.Note.RightFax

Standard preview form RightFax Preview IPM.Note.RightFax.Preview
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Installing the advanced fax form on a client computer

The advanced RightFax form for Outlook is installed on each individual Outlook client computer as 
an optional component during the RightFax client installation (described in the RightFax 
Administrator’s Guide). If you did not install the Outlook forms during the standard client 
installation, run the client Setup program from the RightFax\Client\Win32 folder, and select the 
Typical installation option. If Outlook is installed on the client computer, the advanced Outlook form 
will be installed automatically.

The Outlook Fax Extension

The Outlook Fax Extension is installed as part of the advanced fax form installation (see ”Installing 
the advanced fax form on a client computer” on page 39). The extension adds a menu command and 
button to Outlook so that users can quickly address and send faxes. It also provides a command for 
viewing the status of faxes.

A button, New Fax to Contact, is added to the Outlook tool bar.

Figure 5.1  The New Fax to Contact Button

When the user clicks this button, a Quick Fax Addressing dialog box may appear depending on the 
user’s RightFax configuration in Outlook (see ”Configuring the Outlook Fax Extension” on 
page 40). This dialog box lets the user easily enter the necessary fax addressing information. After 
the addressing dialog box is completed, the fax form opens allowing the user to supply the body of 
the fax message, attach files or library documents, and specify any desired fax transmission options.

The extension adds the menu command Realtime Fax Status to the Actions menu so that users can 
view the status of the faxes stored in the RightFax mailbox. This is useful for users who want to 
check the status of faxes sent to or from Outlook. When this command is selected, a dialog box 
appears listing the folders and faxes in your mailbox. Click a folder name to view the faxes it 
contains. To view, delete, or release a fax held for preview, right-click the fax to open a shortcut 
menu, and then select the appropriate menu option. Right-click in the fax list and select Refresh List 
to view the most current status of each fax.
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Configuring the Outlook Fax Extension

The Outlook Fax Extension must be configured on each Outlook client. On the client computer in 
Outlook, navigate to the Tools menu and select Options. The Options dialog box opens. Select the 
RightFax tab.

Figure 5.2  The RightFax Extension Tab

Use Outlook fax addresses as RightFax addresses. Enables the gateway to send messages to Contacts 
who have a fax number only in the Business Fax field of their Contact information. If this check box 
is not selected, RightFax-specific fax addresses must be used in the Business Fax field.

Remove “(Business Fax)” from cover sheet display name. When faxing to Outlook clients, the name 
of the Contact information field where the fax number was retrieved (the Business Fax field) is 
automatically appended by Outlook to the fax recipient’s name. For example, your Outlook 
Contacts may receive faxes addressed like this:

Jane Doe (Business Fax)

Select this check box to automatically remove this text from your fax cover sheets, leaving only the 
recipient’s name in the To: field.

Allow area codes in parentheses. Prevents Outlook from automatically converting numbers below 
299 inside parentheses in fax-bound mail addresses to escape characters. If you are going to send 
faxes via the gateway for Microsoft Exchange to area codes below 299, this check box must be 
selected.

Note  Checking Allow area codes in parentheses will prevent you from adding special characters to e-mail 
addresses using escape codes.

Show Quick Fax Addressing dialog. When this option is selected, a Quick Fax Addressing dialog box 
will appear each time you create a new fax in Outlook. This dialog box lets you enter fax addressing 
information, which is then formatted automatically in the To line of your Outlook message.

Form for new messages. Specifies which Outlook form to open when you create a new fax. You can 
select the Outlook standard message form, or, if you have installed RightFax forms (see ”Installing 
the RightFax Forms for Outlook” on page 37), you can select the advanced form.

Server options. Click this button to open a dialog that lets you specify the name of the RightFax 
server to connect to and your login information.
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Create internet mail fax addresses. If you use the Outlook client with the SMTP/POP3 e-mail 
gateway instead of the gateway for Microsoft Exchange, selecting this check box tells Outlook to 
create SMTP/POP3 compatible fax addresses instead of Exchange formatted addresses. When this 
option is enabled, you must also enter the Internet mail address of the RightFax SMTP e-mail 
gateway. For example, if fax messages sent to the SMTP/POP3 gateway should be formatted as:

fax=555-1212/pn=Jane.Doe@faxgateway.company.com

then this field must read:

faxgateway.company.com

Because this feature uses IETF addressing convention, you must have the option Use IETF Fax 
Addressing checked in your SMTP/POP3 E-mail Configuration dialog box (described in the RightFax 
Administrator’s Guide)

Sending Faxes

When users select one of the RightFax forms to send a fax, a fax addressing dialog box opens, 
allowing the user to enter the addressing information. After the information is complete, the fax 
form opens, allowing the user to supply the body of the fax message, attach files or library 
documents, and specify any desired fax transmission options.

For instructions on entering this information, please refer to the RightFax Client for Outlook Quick 
Reference Card and the online help.

Sending faxes using the standard fax form

After it has been installed, all Outlook users can open the standard form. The standard form is 
similar to the advanced form but does not include the lookup options.

1. In Outlook, select Forms from the Tools menu, and then click Choose Form.

2. In the Organizational Forms Library, double-click the display name defined for the standard 
form (such as “RightFax.”) This opens the standard fax form for Outlook.

Figure 5.3  The Standard Fax Form in Outlook

For information on using the standard RightFax form for Outlook, please refer to the RightFax Client 
for Outlook Quick Reference Card and the online help provided with the form.
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Sending faxes using the advanced fax form

In order for a user to open the advanced form, the form must have been installed separately on the 
client machine (see ”Installing the advanced fax form on a client computer” on page 39).

There are several ways to use the advanced form to send a fax:

8 Click New Fax to Contact.

8 On the Actions menu, click New Fax.

8 To generate and send a new fax to a Microsoft Outlook Contact, click Contacts in your Outlook 
Folder List, select the contacts to receive the fax, and then click New Fax to Contact on the tool bar.

The form opens, addressed with the name and fax number of the contact. The fax number is 
taken from the contact’s Business Fax fields. If the Business Fax field is empty, the Home Fax field 
is used. If the Home Fax field is empty, the Other Fax field is used. If available, the contact’s 
company, city, state, billing information, and voice number will also be included in the fax 
address for display on the cover sheet.

Figure 5.4  The Advanced Fax Form in Outlook

For information on using the advanced RightFax form for Outlook, please refer to the RightFax Client 
for Microsoft Outlook Quick Reference Card and the online help provided with the form.
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Manually Addressing Outlook Messages to Fax Destinations

To address a fax from Outlook, you can type all the fax information (name, fax number, etc.) in the 
To: field using one of two supported addressing formats, or create custom fax addresses in either 
your Personal Address Book or the Global Address List.

Using the FAX: addressing format

This is a simplified fax addressing type that lets users specify the destination name and fax number 
in the To: field in Outlook using the format:

[FAX:Name@FaxNumber]

For example, to send a fax from Outlook to Jane Doe at 555-1212, enter this address in the To: field:

[FAX:Jane Doe@555-1212]

Be sure to include the opening and closing square brackets.

You can restrict users’ ability to use this addressing type in the RightFax Connector for Microsoft 
Exchange (see ”FAX Addresses” on page 16)

Using the RFAX: addressing format

This is an advanced fax addressing type supported by RightFax that lets users specify the 
destination name and fax number in the To: field in Outlook using the format:

[RFAX:Name@/FN=FaxNumber]

For example, to send a fax from Outlook to Jane Doe at 555-1212, enter this address in the To: field:

[RFAX:Jane Doe@/FN=555-1212]

Be sure to include the opening and closing square brackets.

You must include the recipient’s name and fax number as in the previous example; however, with 
the RFAX addressing type, you can optionally include one or more additional parameters. The 
following table lists all fax destination parameters supported for Outlook. These addressing 
parameters can appear in any order but must always be entered after the ‘@’ symbol in the address.

Example [RFAX:Jane Doe@/FN=555-1212/VN=555-4567/CI=Tucson, AZ/CO=Acme 

Inc./AN=1111/MN=2222]

You can restrict users’ ability to use this addressing type in the RightFax Connector for Microsoft 
Exchange (see ”RFAX Addresses” on page 16).

Table 5C  RFAX Type Outlook Fax Addressing Parameters

Parameter Definition Example

/AN= Billing code 1 /AN=1111

/CI= Recipient city/state /CI=Tucson, AZ

/CO= Recipient company name /CO=Acme, Inc.

/FN= Destination fax number /FN=555-1212

/MN= Billing code 2 /MN=2222

/VN= Recipient voice number /VN=555-4567
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Adding fax entries to your personal address book or the global address list

If you have some fax contacts who you send to regularly, it may save time to add their fax 
addressing information to one of your phonebooks, rather than manually entering their fax 
destination each time.

To add fax address entries to a phonebook

1. In Outlook, create a new message and click To:. This opens the Select Names dialog box. Click 
New to open the New Entry dialog box.

Figure 5.5  The New Entry Dialog Box in Outlook

2. From the list of templates, select RightFax Address, and then select the address book for the new 
entry. Click OK. This opens the New RightFax Address Properties dialog box.

Figure 5.6  The New RightFax Address Properties Dialog Box

3. Fill in the recipient’s fax information. The name you enter under Address Book Information is the 
recipient’s name as it will appear in your address book. It is not included on any sent faxes.

4. When you have entered all the recipient’s fax information, click OK and complete the e-mail 
message. The new entry will now be available in the address book you specified.
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Receiving Incoming Faxes via E-mail

The RightFax e-mail gateway for Exchange lets RightFax users receive faxes as e-mail message 
attachments instead of (or in addition to) receiving them in their FaxUtil mailboxes.

To configure a user to receive faxes in e-mail

1. In Enterprise Fax Manager, double-click the user to open the User Edit dialog box, and then click 
the Inbound Routing tab.

Figure 5.7  The Inbound Routing Tab 

2. In the Routing Type box, select “Microsoft Exchange.”

3. In the File Format list, click “TIFF-G3” as the format RightFax will use for the fax attachment.

4. In the Routing Info box, enter the user’s Outlook Display Name, Alias, or Distinguished Name.

5. If you have installed Outlook forms (see ”Installing the RightFax Forms for Outlook” on 
page 37) select the form you want to route incoming faxes to in the Received Fax Routing Form 
box. Select Default to use the form set in the e-mail gateway configuration in Enterprise Fax 
Manager (see ”Adding and Configuring the Gateway for Microsoft Exchange” on page 6).

6. Select the Delete After Routing check box only if you want to delete the fax from the user’s 
RightFax mailbox after it is routed to Exchange. If RightFax cannot route a fax to the destination 
e-mail mailbox, it will leave the fax in the user’s RightFax mailbox regardless of how this option 
is set.

Breaking up large faxes

Some Exchange servers define a maximum file size for inbound messages. By default, if a fax image 
attached to an inbound mail message exceeds this maximum file size, an error is logged and the 
message is not sent.

In order to bypass this limit, RightFax can be configured to automatically break fax images into 
multiple files and send them as separate mail messages. To do this, add a new DWORD Windows 
registry entry “MaxMessageSize” under 
HKEY_LOCAL_MACHINE\Software\RightFax\Gateway\Gateway#. Set the value of this key to 
the maximum file size in Kb. Any faxes that exceed this size will automatically be divided into 
multiple faxes and multiple mail messages.
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E-mail Notification of Received Faxes

The RightFax e-mail gateway for Exchange can be used for notification of received faxes whether or 
not the gateway is configured to actually send and receive faxes.

To configure a user to receive fax notification in e-mail

1. In Enterprise Fax Manager, double-click the user to open the User Edit dialog box, and then click 
the Notification tab.

Figure 5.8  The Notification Tab 

2. In the Notification Method list, click Microsoft Exchange.

3. In the Notification Address/Info box, enter the Outlook user’s Display Name or Alias. Click OK to 
save the new notification settings.

Group notification

The notification method can be configured for an entire RightFax group by editing the group ID 
properties in Enterprise Fax Manager and setting the group Notification Type to Microsoft Exchange.
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Customizing the subject lines of Exchange user notifications

The subject line of each user notification message in Exchange can be customized by adding a 
Windows registry setting to the fax server. For each message to customize, add a new string registry 
entry under HKEY_LOCAL_MACHINE\Software \RightFax\Gateway\Gateway#. The following 
table lists each registry entry, the type of notification the message applies to, and its default text 
value. Some values let you include variables as part of the string. In each case the variable and its 
definition is listed.

Including the Fax ID in the E-mail Notification

The e-mail notification of a received fax in Microsoft Outlook can include the unique ID of the fax. 
The unique ID appears in the subject line of the e-mail. To change the format of the unique ID, see 
the chapter on routing inbound faxes in the RightFax Administrator’s Guide.

To configure e-mail notification messages to include the fax ID

For the unique ID of the fax to appear in e-mail notification messages, you must modify the 
notification messages on the RightFax server.

1. In Enterprise Fax Manager, select the RightFax server to modify.

2. Under Service Name, double-click RightFax Server Module. The Server Configuration dialog box 
opens.

Table 5D  Custom Exchange Subject Line Registry Settings

Registry key Defines the subject line of Default value

ExchangeMsgs_0

Received Outlook messages 

that contain newly received 
faxes

A new fax has arrived from ~1 (Part ~2 of ~3).

~1 = CSID of originating fax machine
~2 = Fax number (in fax is broken into multiple parts)

~3 = Total fax parts (in fax is broken into multiple parts)

~4 = Fax number (in fax is broken into multiple parts)
~5 = Total fax parts (in fax is broken into multiple parts)

~6 = Fax number (in fax is broken into multiple parts)

ExchangeMsgs_1
Notification that a sent fax 
had an incorrect fax address

Your fax has not been sent because the addressing 
information was incorrect.

ExchangeMsgs_2
Notification that a sent fax 

had an invalid fax address

Valid fax destination information could not be found in 

your mail message. The message has been discarded.

ExchangeMsgs_3
Notification that a sent fax 
had an invalid e-mail 

address

The gateway was unable to validate the e-mail address 
of the message sender. The message has been 

discarded.

ExchangeMsgs_4
Notification that a sent fax 
was not sent due to an error 

during processing

An error occurred while trying to process your message. 
Please try again or contact your system administrator. 

The message has been discarded.

ExchangeMsgs_5
Notification that a sent fax 
was not sent due to an error 

during transmission

An error occurred while trying to send your message. 
Please try again or contact your system administrator. 

The message has been discarded.

ExchangeMsgs_6

Notification that a sent fax 

marked for preview is ready 
to view

Your fax to ~1 is ready for previewing.

~1 = Recipient’s name

ExchangeMsgs_7
Notification that a sent fax 

has not been sent
Your fax has not been sent.

ExchangeMsgs_8
Notification that a sent fax 

had no body content
There is no message body.
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3. On the Custom Messages tab, modify the New Fax message. Type a message that includes the ~5 
variable, which is the unique ID of the fax. The maximum length of a notification message is 200 
characters.

For example, enter the message A new fax has arrived. Fax ID ~5.

Embedded Codes in E-Mail Messages

Embedded codes are special faxing instructions that you insert directly into fax-bound documents 
such as e-mail messages. You can use embedded codes to include fax cover sheet information, attach 
library documents, add billing information, and more.

To add an embedded code to an e-mail message, type the code you want, along with any required 
parameters, between angle brackets. For example, an embedded code that tells RightFax to send a 
library document called “PriceSheet” is written as:

<LIBDOC:PRICESHEET>

RightFax removes all embedded codes from the mail message when it converts it to fax form so they 
don’t appear in your final fax. If you type an embedded code incorrectly, it will be ignored by 
RightFax and included in your fax. Embedded codes may be written in either upper or lower case.

Embedded codes must always use a native printer font. This is because when the mail message is 
converted to PCL5 format, all other font types are encoded as graphic images. Only native printer 
fonts are stored in the PCL file that the fax is generated from in their original text format. And it is 
this text in the PCL file that is replaced. If you do not use native printer fonts for your embedded 
codes, the codes themselves will appear in the instead of being replaced by the information or 
instruction they represent. All embedded codes are surrounded by angle brackets (< >) which must 
also use the same native printer font.

Note  Windows 2000 may add unexpected spacing or other characters to embedded code strings even when 

using a native printer font. For embedded codes in documents on Windows 2000 machines, RightFax 

recommends using the “Courier” native printer font only.

Embedded codes can appear anywhere in the body of the mail message (they will not work in the 
Address or Subject fields). Embedded codes cannot line wrap and any embedded code that is so long 
that it wraps to a second line will be ignored.

For a description and example of each e-mail compatible embedded code see Appendix A, ”E-mail 
Compatible Embedded Codes”.

� � �



RightFax 8.5 Gateway for Microsoft Exchange Guide 49
Appendix A
E-mail Compatible Embedded 
Codes

mbedded codes are special faxing instructions that you insert directly into fax-bound e-mail 
messages. You can use embedded codes to include fax cover sheet information, attach library 
documents, specify a time to send the fax, and more.

To add an embedded code to an e-mail message, type the code you want, along with any required 
parameters, between angle brackets. For example, an embedded code that tells RightFax to include 
the library document “Priceguide” along with the text of the e-mail is written as:

<LIBDOC2:PRICEGUIDE>

RightFax removes all embedded codes from the e-mail message when it converts it to fax form, so 
they don’t appear in your final fax. If you type an embedded code incorrectly, it will be ignored by 
RightFax and will be included in your fax. Embedded codes may be written in either upper or lower 
case and embedded codes always work the same way regardless of the e-mail application used to 
create the document.

Although you can use any fonts you want in the text of your e-mail messages, embedded codes 
must always use a native printer font. This is because when the file is converted to PCL5 format, all 
other font types are encoded as graphic images. Only native printer fonts are stored in the PCL file 
in their original text format. It is this text in the PCL file that is replaced. If you do not use native 
printer fonts for your embedded codes, the codes themselves will appear in the instead of being 
replaced by the information or instruction they represent. All embedded codes are surrounded by 
angle brackets (< >) which must also use the same native printer font.

Note  Windows 2000 may add unexpected spacing or other characters to embedded code strings even 

when using a native printer font. For embedded codes in documents on Windows 2000 machines, RightFax 

recommends using the “Courier” native printer font only.

Embedded codes can be placed anywhere in the e-mail message that you will be faxing. They 
cannot line wrap and any embedded code statement that is so long that it wraps to a second line 
will be ignored.

This appendix lists only embedded codes that are recognized by the e-mail gateways. RightFax 
supports several additional embedded codes when faxes are generated from native applications. 
For a complete list of embedded codes supported by RightFax, please refer to the RightFax 
Administrator’s Guide.

E
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ATDATE (AT_DATE)

Format <ATDATE:date>

Schedules the fax to send on a specific date. Dates can be expressed as relative or absolute. Relative 
dates give the number of days from today’s date. For example, “+7” represents one week from 
today. Absolute dates specify the exact date to send the fax. Absolute dates must be written in one 
of these formats: MM/DD/YY, MM-DD-YY, or MM-DD-YYYY.

If no send time is specified with the ATTIME code (described later), the send time defaults to “now” 
(the current time of processing). For example, if a fax is sent to the queue at 3:30 p.m. and it contains 
only an <ATDATE:+1> code, it will automatically be scheduled to send at 3:30 p.m. tomorrow.

Maximum field length: 10 characters

Example <ATDATE:9-15-99>

<AT_DATE:+2>

ATTIME (AT_TIME)

Format <ATTIME:time>

Schedules the fax to send at a specific time. The time can be relative or absolute.

Relative time is the number of hours or minutes from the current time. For example, “+2” is two 
hours from now. You can enter fractions of an hour in six-minute increments. Valid fractions of an 
hour are 0.1 through 0.9. You must enter at least one digit before and after the decimal point. For 
example, 1.5 and 0.3 are valid, and 1.50 and .3 are not valid.

Absolute times are entered in either 12-hour or 24-hour format. A colon separating hours and 
minutes is optional, and an “a” or “p” can be used to indicate A.M. or P.M. The fax server does not 
send the fax at exactly the minute specified. Rather, the fax becomes eligible for scheduling within 
15 minutes of the specified time.

Specifying a time between the current time and midnight will schedule the fax to send today. 
Specifying a time earlier than the current time will schedule the fax tomorrow.

Maximum field length: 9 characters

Example <RFSAP_ATTIME:10:00p>

<RFSAP_AT_TIME:+2>

BILLINFO1 (BI1)

Format <BILLINFO1:code>

Assigns a billing code to the fax. The billing code will be sent but it will not be validated by 
RightFax.

Maximum field length: 15 characters

Example <BILLINFO1:4444>

BILLINFO2 (BI2)

Format <BILLINFO2:code>

Assigns a second billing code to the fax. The billing code will be sent but it will not be validated by 
RightFax.

Maximum field length: 15 characters

Example <BILLINFO2:5555>
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CHANNEL

Format <CHANNEL:channel#>

Sends the fax only on the specified channel of the fax board. Specify a number corresponding to the 
channel to use. Set the channel number to 0 (zero) to use any available channel.

This code is useful if your organization uses one channel for priority faxing, and you want the fax to 
go out right away. You can also use this code to limit fax broadcasts to one channel only, leaving the 
other channels free for priority faxing.

Maximum field length: N/A

Example <CHANNEL:3>

COVER

Format <COVER>

Automatically generates a RightFax cover sheet for the fax containing the code. If the user sending 
the fax containing this code is configured to automatically generate a cover sheet, only one cover 
sheet will be generated.

Unless a cover sheet file name is specified using the <FCSFILE> embedded code (see ”FCSFILE” on 
page 51), this code will automatically use the default cover sheet file.

Maximum field length: N/A

DELETE (AUTODELETE)

Format <DELETE>

Deletes the fax from the user’s FaxUtil mailbox after it has been successfully sent. This code 
overrides the default RightFax auto-delete setting.

Maximum field length: N/A

DELETEALL (AUTODELETEALL)

Format <RFSAP_DELETEALL>

Deletes the fax from the user’s FaxUtil mailbox after it has been sent, whether or not the send was 
successful. This code overrides the default RightFax auto-delete setting.

Maximum field length: N/A

FCSFILE

Format <FCSFILE:file name>

Uses the specified file as the RightFax-generated cover sheet. The cover sheet file must exist in the 
RightFax\FCS folder on the RightFax server and must end with the extension .pcl. Do not specify a 
directory path.

Maximum field length: 12 characters

Example <FCSFILE:MYCOVER1.PCL>
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FINE

Format <FINE>

Converts the body of the fax using “fine” resolution (200 × 200 DPI). Fine resolution is 
recommended for faxes with detailed graphics and faxes that will be OCRed. This code overrides 
the default fax resolution set in the user's FaxUtil mailbox.

Maximum field length: N/A

FROMFAXNUM (FROM_FAXNUM)

Format <FROMFAXNUM:faxnumber>

Specifies the sender’s fax number on the RightFax-generated fax cover sheet. If no cover sheet is 
generated by RightFax, this code will be ignored.

Maximum field length: 31 characters

Example <FROMFAXNUM:(520)555-1234>

FROMGENFAXNUM (FROM_GENFAXNUM)

Format <FROMGENFAXNUM:faxnumber>

Specifies the company’s general fax number to be placed on the RightFax-generated fax cover sheet. 
If no cover sheet is generated by RightFax, this code will be ignored.

Maximum field length: 31 characters

Example <FROMGENFAXNUM:(520)555-2345>

FROMGENPHONE (FROM_GENPHONE)

Format <FROMGENPHONE:phonenumber>

Specifies the company’s general phone number to be placed on the RightFax-generated fax cover 
sheet. If no cover sheet is generated by RightFax, this code will be ignored.

Maximum field length: 31 characters

Example <FROMGENPHONE:(520)555-3456>

FROMPHONE (FROM_PHONE)

Format <FROMPHONE:phonenumber>

Specifies the sender’s phone number to be placed on the RightFax-generated fax cover sheet. If no 
cover sheet is generated by RightFax, this code will be ignored.

Maximum field length: 31 characters

Example <FROMPHONE:(520)555-4567>

IGNORE

Format <IGNORE>

Causes all subsequent embedded codes to be ignored.

Maximum field length: N/A
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LIBDOC

Format <LIBDOC:documentID>

Sends the specified RightFax library document instead of sending the document containing the 
code. Multiple library documents may be specified, each as a separate LIBDOC code.

Maximum field length: 21 characters

Example <LIBDOC:INFOPACK1>

LIBDOC2

Format <LIBDOC2:documentID>

Sends the specified RightFax library document in addition to sending the document containing the 
code. Multiple library documents may be specified, each as a separate LIBDOC2 code.

Maximum field length: 21 characters

Example <LIBDOC2:INFOPACK1>

NOCOVER

Format <NOCOVER>

Turns off automatic RightFax cover sheet generation for the document containing this code.

Maximum field length: N/A

NORMAL

Format <NORMAL>

Converts the body of the fax using “normal” resolution (100 × 100 DPI). Normal resolution faxes 
can be transmitted much faster than fine resolution faxes, saving time and phone charges. This code 
overrides the default fax resolution set in the user’s FaxUtil mailbox.

Maximum field length: N/A

PREVIEW

Format <PREVIEW>

Holds the fax for preview in your FaxUtil mailbox. You must view the fax in FaxUtil and select 
Release from the File menu before it will send.

Maximum field length: N/A

PRIORITY

Format <PRIORITY:priority>

Sets the priority of the outgoing fax. Allowed settings are: Low (L), Normal (N), and High (H). If a 
user specifies high priority and does not have the “Can use high priority” permission, the fax will 
automatically be sent with “normal” priority.

Maximum field length: N/A

Examples <PRIORITY:HIGH>

<PRIORITY:N>
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SAVE

Format <SAVE>

Instructs RightFax to not delete the fax image from the user’s FaxUtil mailbox after being sent. This 
overrides any default auto-delete setting.

Maximum field length: N/A

UNIQUEID

Format <UNIQUEID:faxID>

Specifies a unique ID for the fax instead of having one automatically generated by RightFax. 
Custom IDs may be used for external document tracking systems.

Maximum field length: 15 characters

Example <UNIQUEID:XYZ120396>

� � �
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Appendix B
File Formats that Convert to 
Fax Format

he following table lists the software applications and document file formats that can be 
converted to faxes by the built-in conversion engine on the RightFax server. Only these file types 
can be converted from their native format by using the Send To function in Windows or by 

sending as file attachments to a fax message.

Table BA  Document File Formats

Application or file format Supported versions

Access Versions through 2.0

AMI/AMI Professional Versions through 3.1

ANSI text All versions

ASCII text All versions

Binary group 3 fax All versions

BMP (including RLE, ICO, CUR & OS/2 DIB) Windows

CDR (if TIFF image is embedded in it) Corel Draw versions 2.0 through 9.0

dBASE Versions through 5.0

DCX (multi-page PCX) Microsoft Fax

DRW (Micrografx Designer) Version 3.1

EPS (if TIFF image is embedded in it) Encapsulated PostScript

Freelance for Windows Version 1.0, 2.0, 96, 97, and Millennium

GIF CompuServe

HTML Versions through 3.0

JPEG All versions

Lotus 1-2-3 (DOS & Windows) Versions through 5.0

Lotus 1-2-3 (Windows) Versions through 97

Lotus 1-2-3 Charts (DOS & Windows) Versions through 5.0

MAC MacPaint

Microsoft Excel (Macintosh) Versions 3.0 through 4.0, 98

Microsoft Excel (Windows) Versions 2.2 through 2000

Microsoft Excel Charts Versions 2.x through 7.0

Microsoft PowerPoint (Macintosh) Version 4.0, 98

Microsoft PowerPoint (Windows) Versions through 2000

Microsoft Windows Works Versions through 4.0

T
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Microsoft Works (DOS) Versions through 2.0

Microsoft Write Versions through 3.0

Microsoft Word (DOS) Versions through 6.0

Microsoft Word (Macintosh) Versions 4.0 through 98

Microsoft Word for Windows Versions through 2000

Microsoft WordPad All versions

Microsoft Works (Macintosh) Versions through 2.0

Paradox (Windows) Versions through 1.0

PCX bitmap PC Paintbrush

PICT1 & PICT2 (Raster) Macintosh Standard

QuattroPro for Windows Versions through 9.0

Microsoft Rich Text Format (RTF) All versions

TIFF Versions through 6.0

TIFF CCITT Group 3 & 4 Fax Systems

Unicode Text All versions

WMF Windows Metafile

WordPerfect (DOS) Versions through 6.1

WordPerfect (Macintosh) Versions 1.02 through 3.0

WordPerfect for Windows Versions through 9.0

WordPerfect Graphics (WPG and WPG2) Versions through 2.0

Table BA  Document File Formats (continued)

Application or file format Supported versions
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